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โปรแกรมด้วยภาษา Visual C# 
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CHAPTER

01

โลกของการเขยีนโปรแกรมไม่ได้มแีต่เพยีงแค่พฒันาโปรแกรมบน PC เพยีงอย่างเดยีวเท่าน้ัน แต่ยังรวมไปถงึ 

มือถือและแท็บเล็ตอีกด้วย

ไมโครซอฟท์พัฒนา Visual Studio 2015 (เรียกสั้นๆ ว่า VS 2015) ขึ้นมา เพื่อรองรับการพัฒนา

โปรแกรม 3 ช่องทาง คือ

1. พัฒนาโปรแกรมส�าหรับ PC (หรือ Notebook) 

2. พัฒนาโปรแกรมบนเว็บ (ไม่ขึ้นกับแพลตฟอร์ม) 

3. พัฒนาโปรแกรมส�าหรับมือถือและแท็บเล็ต (iOS, Android และ Windows Apps)

ในปัจจุบันไมโครซอฟท์พัฒนา Windows 10 ขึ้นมา ท�าให้โลกของโปรแกรมบน PC, มือถือและแท็บเล็ต 

กลายเป็นโลกเดียวกัน ส่งผลให้นักพัฒนาไม่ต้องเสียเวลาเรียนรู้ซ�้าซ้อนหลายขั้นตอนอีกต่อไป

เน้ือหาที่จะน�าเสนอในหนังสือเล่มน้ีครอบคลุมการพัฒนาโปรแกรมบน Desktop, Web, มือถือและ

แท็บเล็ต โดยอาศัยภาษา Visual C# 2015 (เรียกสั้นๆ ว่า VC# 2015) ที่มีเนื้อหาสาระเพียงพอที่จะต่อยอด

เป็นโปรแกรมเมอร์มืออาชีพในล�าดับต่อไปได้ไม่ยาก
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จากรูปที่ 1-1 ขอให้ผู้อ่านดาวน์โหลดเวอร์ชัน Community Edition มาใช้งานได้ฟรี

2. การติดตั้ง Visual Studio แบบ Typical เป็นการติดตั้งแบบปกติ (ไม่รวมโปรเจ็กต์ประเภท Windows 

10 Apps)

3. ในกรณีที่ผู้อ่านต้องการพัฒนา Windows 10 Apps ด้วย ขอให้ติดตั้ง Visual Studio 2015 บน 

Windows 10 และเลือกติดตั้งแบบ Custom

รูปที่ 1-1

แสดงหน้าเว็บเพจ
ที่ให้ดาวน์โหลด 
Visual Studio

รูปที่ 1-2

แสดงการติดตั้ง
โปรแกรม Visual 
Studio 2015 
Community 
Edition

กรอก1.1

คลิก1.2

เลือก 2.1

คลิก2.3

คลิก 2.2

กำรดำวน์โหลดและติดตั้ง Visual Studio 2015
ผู้อ่านสามารถเขียนโปรแกรมในตระกลู .NET ได้โดยการใช้โปรแกรมทีช่ือ่ว่า Visual Studio ซึง่มขีัน้ตอนดงันี้

1. ให้ผูอ่้านไปทีเ่ว็บไซต์ https://www.visualstudio.com/downloads/download-visual-studio-vs เพือ่

ดาวน์โหลดโปรแกรม Visual Studio เวอร์ชันล่าสุดเท่าที่มีอยู่ในปัจจุบัน ดังรูปที่ 1-1
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รูปที่ 1-4

แสดงการเลือก
รายการ Show 
New Project 
dialog box

รูปที่ 1-3

กรณีติดตั้ง 
Visual Studio 
แบบ Custom

จากรูปที่ 1-3 ที่รายการ Universal Windows App Development Tools ให้ผู้อ่านเลือกติดตั้งเพิ่มเติม 

คือตัว Windows 10 SDK กับ Emulators ส�าหรับรันมือถือ Windows 10 

กำรตั้งคำ Visual Studio 2015 เบ้ืองต้น
ก่อนเริม่ต้นเรยีนรูก้ารพฒันาแอพพลเิคชนัด้วย Visual Studio 2015 ผู้เขียนอยากจะแนะน�าให้ผูอ่้านรูจ้กั

การตั้งค่าต่างๆ ที่ช่วยให้การพัฒนาแอพพลิเคชันต่างๆ ง่ายขึ้นดังนี้

กำรก�ำหนดให้แสดงไดอะล็อกเลือกโปรเจ็กต์ (New Project Dialog)
เพ่ือเป็นการอ�านวยความสะดวกในการสร้างโปรเจ็กต์ใหม่ทุกครั้ง ผู้อ่านสามารถก�าหนดให้ VS แสดง

ไดอะล็อกเลือกสร้างโปรเจ็กต์ทุกครั้งเมื่อมีการเปด Visual Studio 2015 ขึ้นมาโดยมีขั้นตอนดังนี้

1. คลิกเมนู Tools > Options... 

เลือก1
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2. จะปรากฏไดอะล็อก Options ให้คลิกเลือก Environment > Startup 

3. เลือกรายการ Show New Project dialog box 

4. คลิกปุม 

5. จะปรากฏไดอะล็อกส�าหรับสร้างโปรเจ็กต์ใหม่ดังรูป

คลิก 2

คลิก3

คลิก4

รูปที่ 1-5

แสดงไดอะล็อกเลือก
สร้างโปรเจ็กต์ใหม่

จากรูปที่ 1-5 ผู้อ่านสามารถเลือกสร้างโปรเจ็กต์ใน VS ได้ตามที่ต้องการได้จากไดอะล็อกนี้

 กำรก�ำหนดเลขบรรทัด
การก�าหนดให้ Visual Studio 2015 แสดงหมายเลขก�ากับโค้ดในแต่ละบรรทัด ผู้อ่านสามารถท�าได้โดย

มีขั้นตอนดังนี้

รูปที่ 1-4 (ตอ)

แสดงการเลือก
รายการ Show 
New Project 
dialog box

บทที่ 1 เตรียมความพร้อมก่อนเริ่มต้นเขียนโปรแกรมด้วยภาษา Visual C# 2015 3
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รูปที่ 1-4

แสดงการเลือก
รายการ Show 
New Project 
dialog box

รูปที่ 1-3

กรณีติดตั้ง 
Visual Studio 
แบบ Custom

จากรูปที่ 1-3 ที่รายการ Universal Windows App Development Tools ให้ผู้อ่านเลือกติดตั้งเพิ่มเติม 

คือตัว Windows 10 SDK กับ Emulators ส�าหรับรันมือถือ Windows 10 

กำรตั้งคำ Visual Studio 2015 เบ้ืองต้น
ก่อนเริม่ต้นเรยีนรูก้ารพฒันาแอพพลเิคชนัด้วย Visual Studio 2015 ผู้เขียนอยากจะแนะน�าให้ผูอ่้านรูจ้กั

การตั้งค่าต่างๆ ที่ช่วยให้การพัฒนาแอพพลิเคชันต่างๆ ง่ายขึ้นดังนี้

กำรก�ำหนดให้แสดงไดอะล็อกเลือกโปรเจ็กต์ (New Project Dialog)
เพื่อเป็นการอ�านวยความสะดวกในการสร้างโปรเจ็กต์ใหม่ทุกคร้ัง ผู้อ่านสามารถก�าหนดให้ VS แสดง

ไดอะล็อกเลือกสร้างโปรเจ็กต์ทุกครั้งเมื่อมีการเปด Visual Studio 2015 ขึ้นมาโดยมีขั้นตอนดังนี้

1. คลิกเมนู Tools > Options... 

เลือก1
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1. คลิกเมนู Tools > Options 

2. จะปรากฏไดอะล็อก Options ให้คลิกเลือก Text Editor > All Languages 

3. คลิกเลือก   Line numbers 

4. คลิกปุม 

คลิก 2

เลือก 3

คลิก4

รูปที่ 1-6

รูปที่ 1-6 แสดง
การกําหนดให้
แสดงหมายเลข
กํากับโค้ดแต่ละ
บรรทัด

เลือก1

กำรสร้ำงโปรเจ็กต์ใหม
การสร้างโปรเจก็ต์ใหม่ถอืเป็นจดุเริม่ต้นของการพฒันาแอพพลเิคชนัต่างๆ ในทีน่ีจ้ะเริม่ต้นจาก Windows 

Forms Application ซึ่งเป็นโปรเจ็กต์หลักของ Visual C# 2015 โดยมีขั้นตอนดังนี้

1. ให้ผู้อ่านคลิกเมนู File > New > Project… 

2. เลือกเมนู Visual C# > Windows

3. เลือกสร้างโปรเจ็กต์แบบ Windows Forms Application ซึ่งเป็นโปรเจ็กต์ที่ใช้สร้างโปรแกรมส�าหรับ

ท�างานบน Windows 

4. กรอกชื่อโปรเจ็กต์
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5. เลือกต�าแหน่งที่อยู่ของโปรเจ็กต์

6. คลิกปุม 

7. จะปรากฏหน้า Windows Forms Application ส�าหรับสร้างโปรเจ็กต์ดังรูป

รูปที่ 1-7

แสดงการสร้าง
โปรเจ็กต์แบบ 
Windows Forms 
Application

รูปที่ 1-8

แสดงสภาพแวดล้อม
ของ VS แบบ 
Windows Forms 
Application

เลือก1

คลิก 2 เลือก3

กรอกชื่อ4
คลิก5

คลิก 6
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1. คลิกเมนู Tools > Options 

2. จะปรากฏไดอะล็อก Options ให้คลิกเลือก Text Editor > All Languages 

3. คลิกเลือก   Line numbers 

4. คลิกปุม 

คลิก 2

เลือก 3

คลิก4

รูปที่ 1-6

รูปที่ 1-6 แสดง
การกําหนดให้
แสดงหมายเลข
กํากับโค้ดแต่ละ
บรรทัด

เลือก1

กำรสร้ำงโปรเจ็กต์ใหม
การสร้างโปรเจก็ต์ใหม่ถอืเป็นจดุเริม่ต้นของการพฒันาแอพพลเิคชนัต่างๆ ในทีน่ีจ้ะเริม่ต้นจาก Windows 

Forms Application ซึ่งเป็นโปรเจ็กต์หลักของ Visual C# 2015 โดยมีขั้นตอนดังนี้

1. ให้ผู้อ่านคลิกเมนู File > New > Project… 

2. เลือกเมนู Visual C# > Windows

3. เลือกสร้างโปรเจ็กต์แบบ Windows Forms Application ซึ่งเป็นโปรเจ็กต์ที่ใช้สร้างโปรแกรมส�าหรับ

ท�างานบน Windows 

4. กรอกชื่อโปรเจ็กต์
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ท�ำควำมรู้จักกับโปรเจ็กต์ประเภทอ่ืนๆ ของ Visual Studio 2015
นอกเหนือไปจากโปรเจ็กต์ประเภท Windows Forms Application แล้ว ตัวโปรแกรม Visual Studio 

2015 ยังรองรับการพัฒนาแอพฯ ประเภทต่างๆ อีกมากมาย 

รูปที่ 1-9

แสดงไดอะล็อก
สร้างโปรเจ็กต์
ประเภทต่างๆ ของ 
Visual Studio 
2015

โปรเจ็กต์ประเภท Windows 
โปรเจ็กต์ประเภท Windows ยังถูกแบ่งออกเป็น 3 ประเภท คือ
z	 Universal เป็นการพัฒนาแอพฯ ที่รันบนระบบปฏิบัติการ Windows 10 โดยที่ผู้อ่านสามารถสร้าง

โปรเจ็กต์ขึ้นมาเพียง 1 โปรเจ็กต์ แอพฯ ที่ได้มาจะรันได้ทั้ง PC, แท็บเล็ตและมือถือ
z	 Windows 8 เป็นการพัฒนาแอพฯ ที่รันบนระบบปฏิบัติการ Windows 8/8.1 เท่านั้น
z	 Classic Desktop เป็นการพัฒนาแอพฯ แบบเดิมที่เราคุ้นเคยกันเป็นอย่างดี แอพฯ ที่ได้มาก็คือไฟล์ 

exe สามารถตดิตัง้ในระบบปฏบิตักิาร Windows ต่างๆ ทีม่กีารตดิตัง้ .NET Framework ตามเวอร์ชนั

ที่เราเป็นผู้สร้างโปรเจ็กต์ขึ้นมา

โปรเจ็กต์ประเภท Web
ถ้าคุณต้องการสร้างเวบ็ไซต์ต่างๆ เช่น เวบ็แสดงรปูภาพ, เวบ็บอร์ด, เวบ็ข่าวสาร ฯลฯ แสดงผลในบราวเซอร์ 

เราถือว่าเป็นโปรเจ็กต์ประเภท Web อยู่ในความรับผิดชอบของภาษา ASP.NET

โปรเจ็กต์ประเภท JavaScript
เดิมทีเดียวภาษา JavaScript ถูกน�ามาใช้พัฒนาด้าน Web Application เพียงอย่างเดียวเท่านั้น แต่ใน

ปัจจุบันภาษา JavaScript ถูกน�ามาพัฒนาแอพฯ ได้ทั้งแบบ Web Apps กับ Mobile Apps อีกด้วย
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จากรปูที่ 1-10 ภาษา JavaScript ใน Visual Studio 2015 ในขัน้ตน้สามารถสร้างโปรเจ็กต์ได้ 3 แบบ คอื
z	 Apache Cordova Apps เป็นการใช้งานภาษา JavaScript ร่วมกับภาษา HTML5 เพื่อสร้างแอพฯ 

ที่สามารถรันบนมือถือโดยอาศัย Cordova (อาจจะเรียกว่า PhoneGap ก็ได้)
z	 Node.js เป็นการพัฒนา Web Apps ที่รันได้ทั้งฝั่ง Server/Client โดยอาศัยภาษา JavaScript เพียง

ภาษาเดียว
z	 Windows – Universal เป็นการพัฒนาแอพฯ ที่รันบน Windows 10 (PC, แท็บเล็ต และมือถือ) 

โดยอาศัยภาษา HTML5 ร่วมกับภาษา JavaScript

โปรเจ็กต์ประเภท TypeScript
ภาษา TypeScript เป็นภาษาใหม่ที่ไมโครซอฟท์สร้างขึ้นมา โดยมีหลักการที่ว่าทุกสิ่งทุกอย่างของภาษา  

JavaScript คือภาษา TypeScript และเพิ่มเติมความสามารถอื่นๆ ในตัวภาษา TypeScript อีกด้วย เช่น การ

ก�าหนดประเภทข้อมูล, การสร้างคลาสขึ้นมาใช้งานเองได้ เป็นต้น เป็นภาษาสคริปต์ที่ก�าลังได้รับความนิยมเป็น

อย่างมาก

รูปที่ 1-10

แสดงโปรเจ็กต์
ประเภท  
JavaScript

รูปที่ 1-11

แสดงโปรเจ็กต์
ประเภท Type-
Script
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ท�ำควำมรู้จักกับโปรเจ็กต์ประเภทอื่นๆ ของ Visual Studio 2015
นอกเหนือไปจากโปรเจ็กต์ประเภท Windows Forms Application แล้ว ตัวโปรแกรม Visual Studio 

2015 ยังรองรับการพัฒนาแอพฯ ประเภทต่างๆ อีกมากมาย 

รูปที่ 1-9

แสดงไดอะล็อก
สร้างโปรเจ็กต์
ประเภทต่างๆ ของ 
Visual Studio 
2015

โปรเจ็กต์ประเภท Windows 
โปรเจ็กต์ประเภท Windows ยังถูกแบ่งออกเป็น 3 ประเภท คือ
z	 Universal เป็นการพัฒนาแอพฯ ที่รันบนระบบปฏิบัติการ Windows 10 โดยที่ผู้อ่านสามารถสร้าง

โปรเจ็กต์ขึ้นมาเพียง 1 โปรเจ็กต์ แอพฯ ที่ได้มาจะรันได้ทั้ง PC, แท็บเล็ตและมือถือ
z	 Windows 8 เป็นการพัฒนาแอพฯ ที่รันบนระบบปฏิบัติการ Windows 8/8.1 เท่านั้น
z	 Classic Desktop เป็นการพัฒนาแอพฯ แบบเดิมที่เราคุ้นเคยกันเป็นอย่างดี แอพฯ ที่ได้มาก็คือไฟล์ 

exe สามารถตดิตัง้ในระบบปฏบิตักิาร Windows ต่างๆ ทีม่กีารตดิตัง้ .NET Framework ตามเวอร์ชนั

ที่เราเป็นผู้สร้างโปรเจ็กต์ขึ้นมา

โปรเจ็กต์ประเภท Web
ถ้าคณุต้องการสร้างเวบ็ไซต์ต่างๆ เช่น เวบ็แสดงรปูภาพ, เวบ็บอร์ด, เวบ็ข่าวสาร ฯลฯ แสดงผลในบราวเซอร์ 

เราถือว่าเป็นโปรเจ็กต์ประเภท Web อยู่ในความรับผิดชอบของภาษา ASP.NET

โปรเจ็กต์ประเภท JavaScript
เดิมทีเดียวภาษา JavaScript ถูกน�ามาใช้พัฒนาด้าน Web Application เพียงอย่างเดียวเท่านั้น แต่ใน

ปัจจุบันภาษา JavaScript ถูกน�ามาพัฒนาแอพฯ ได้ทั้งแบบ Web Apps กับ Mobile Apps อีกด้วย
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จากรปูที ่1-11 ภาษา TypeScript ใน Visual Studio 2015 ในขัน้ต้นสามารถสร้างโปรเจ็กต์ได้ 2 แบบ คอื
z	 Apache Cordova Apps เป็นการใช้งานภาษา TypeScript ร่วมกับภาษา HTML5 เพื่อสร้างแอพฯ 

ที่สามารถรันบนมือถือโดยอาศัย Cordova (อาจจะเรียกว่า PhoneGap ก็ได้)
z	 Node.js เป็นการพัฒนา Web Apps ที่รันได้ทั้งฝั่ง Server/Client โดยอาศัยภาษา TypeScript 

เพียงภาษาเดียว

โปรเจ็กต์ประเภท Cloud
ในปัจจุบันการขอใช้บริการต่างๆ บนก้อนเมฆ (Cloud) ได้รับความนิยมเป็นอย่างมาก บริการ Cloud ของ

ไมโครซอฟท์ชื่อว่า Azure เราสามารถสร้างโปรเจ็กต์ได้ 2 รูปแบบใหญ่ๆ คือ
z	 โปรเจ็กต์ประเภท ASP.NET Web Application เป็นการพัฒนา Web Apps ด้วยภาษา ASP.NET 

เพื่อขอใช้บริการต่างๆ ใน Azure
z	 โปรเจ็กต์ประเภท Azure Mobile Service เป็นการสร้างบริการที่เชื่อมต่อกับ Azure ให้บริการด้าน

ต่างๆ โดยอาศัยโครงสร้างของ Web API ส�าหรับอุปกรณ์ประเภท Mobile Devices ต่างๆ

รูปที่ 1-12

แสดงโปรเจ็กต์
ประเภท Cloud

ประเภทโปรเจ็กต์ที่ผู้เขียนน�าเสนอรายละเอียดในขั้นต้นนี้ เป็นการติดตั้งเพิ่มเติมแยกต่างหาก เพื่อแสดง

ให้เห็นถึงความสามารถของตัวโปรแกรม Visual Studio 2015 ที่มีอยู่มากมาย
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ท�ำควำมรู้จักกับสภำพแวดล้อม (IDE) ของ VS ในขั้นต้น
VS 2015 รองรับการพัฒนาแอพฯ หลายแพลตฟอร์ม (PC, มือถือ และแท็บเล็ต) โดยที่ผู้อ่านสามารถ

เลือกสร้างโปรเจ็กต์ได้ตามความต้องการของผู้อ่าน สภาพแวดล้อมของโปรเจ็กต์แต่ละประเภทมีลักษณะคล้าย

กัน เพื่อให้นักพัฒนาคุ้นเคยนั่นเอง

ผู้เขียนขอยกตัวอย่างสภาพแวดล้อมของโปรเจ็กต์ประเภท Windows Forms Application มาอธิบายดัง

รูปที่ 1-13

รูปที่ 1-13

แสดงสภาพแวดล้อม 
IDE ของ VS แบบ 
Windows Forms 
Application

z	 หมายเลข 1 แถบเครื่องมือส�าหรับทดสอบโปรเจ็กต์ปัจจุบัน
z	 หมายเลข 2 แถบคอนโทรลส�าเรจ็รปู ท�าหน้าทีอ่อกแบบส่วนแสดงผล (User Interface เรยีกย่อๆ ว่า UI)  

ภายในโปรเจ็กต์ของผู้อ่าน
z	 หมายเลข 3 ส่วนแสดงผลจ�าลอง ผูอ่้านสามารถออกแบบส่วนแสดงผลให้กบัหน้าจอต่างๆ ได้ท่ีนี ่โดย

การลากคอนโทรลต่างๆ มาวาดตามที่ต้องการ
z	 หมายเลข 4 เรยีกว่า หน้าต่าง Solution Explorer ท�าหน้าทีแ่สดงโครงสร้างโปรเจก็ต์ปัจจบุนัของผูอ่้านว่า 

ประกอบไปด้วยไฟล์อะไรบ้าง
z	 หมายเลข 5 เรียกว่า หน้าต่างคุณสมบัติ (Properties) ท�าหน้าที่แสดงคุณสมบัติต่างๆ ของคอนโทรล

ที่ก�าลังถูกโฟกัสในส่วนแสดงผลจ�าลองว่ามีคุณสมบัติอะไรบ้าง ผู้อ่านสามารถแก้ไขคุณสมบัติต่างๆ 

ได้ตามที่ต้องการเช่นกัน เช่น ตั้งชื่อคอนโทรลได้ที่คุณสมบัติ Name, ก�าหนดสีพื้นหลังได้ที่คุณสมบัติ 

BackColor เป็นต้น

2 4

5

3

1
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จากรปูที ่1-11 ภาษา TypeScript ใน Visual Studio 2015 ในขัน้ต้นสามารถสร้างโปรเจ็กต์ได้ 2 แบบ คอื
z	 Apache Cordova Apps เป็นการใช้งานภาษา TypeScript ร่วมกับภาษา HTML5 เพื่อสร้างแอพฯ 

ที่สามารถรันบนมือถือโดยอาศัย Cordova (อาจจะเรียกว่า PhoneGap ก็ได้)
z	 Node.js เป็นการพัฒนา Web Apps ที่รันได้ทั้งฝั่ง Server/Client โดยอาศัยภาษา TypeScript 

เพียงภาษาเดียว

โปรเจ็กต์ประเภท Cloud
ในปัจจุบันการขอใช้บริการต่างๆ บนก้อนเมฆ (Cloud) ได้รับความนิยมเป็นอย่างมาก บริการ Cloud ของ

ไมโครซอฟท์ชื่อว่า Azure เราสามารถสร้างโปรเจ็กต์ได้ 2 รูปแบบใหญ่ๆ คือ
z	 โปรเจ็กต์ประเภท ASP.NET Web Application เป็นการพัฒนา Web Apps ด้วยภาษา ASP.NET 

เพื่อขอใช้บริการต่างๆ ใน Azure
z	 โปรเจ็กต์ประเภท Azure Mobile Service เป็นการสร้างบริการที่เชื่อมต่อกับ Azure ให้บริการด้าน

ต่างๆ โดยอาศัยโครงสร้างของ Web API ส�าหรับอุปกรณ์ประเภท Mobile Devices ต่างๆ

รูปที่ 1-12

แสดงโปรเจ็กต์
ประเภท Cloud

ประเภทโปรเจ็กต์ที่ผู้เขียนน�าเสนอรายละเอียดในขั้นต้นนี้ เป็นการติดตั้งเพิ่มเติมแยกต่างหาก เพื่อแสดง

ให้เห็นถึงความสามารถของตัวโปรแกรม Visual Studio 2015 ที่มีอยู่มากมาย
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มือใหมต้องทรำบกอนเขียนโปรแกรมในโลกของ .NET
ก่อนทีจ่ะเข้าสูร่ายละเอยีดของการเขยีนโปรแกรมในโลกของ .NET Frawework ผูเ้ขยีนจะขอน�าเสนอหลักการ

พ้ืนฐานในภาพกว้างท่ีมือใหม่ต้องทราบในขั้นต้นเสียก่อน เพื่อปูพื้นฐานก่อนที่จะเข้าสู่รายละเอียดเนื้อหาส่วน

ต่างๆ ในแต่ละบทต่อไป

กำรออกแบบสวนแสดงผลด้วยคอนโทรล ( User Interface)
ไม่ว่าผู้อ่านจะสร้างโปรเจ็กต์ประเภทใดก็ตามใน Visual Studio 2015 ไมโครซอฟท์ก�าหนดให้สภาพ

แวดล้อมของตัวโปรแกรม Visual Studio 2015 มีลักษณะคล้ายกัน ใกล้เคียงกันมากที่สุดเท่าที่จะเป็นไปได้ เพื่อ

ให้นักพัฒนาคุ้นเคยกับตัวโปรแกรมได้ไม่ยาก

แม้ว่าภาพประกอบผู้เขียนจะใช้โปรเจ็กต์ประเภท Windows Forms Application ก็จริงอยู่ แต่สามารถ

เทียบเคียงได้กับโปรเจ็กต์ประเภทอื่นๆ ได้อีกด้วย ซึ่งจะเป็นเนื้อหาในภาคต่างๆ ในล�าดับต่อไป 

ก่อนอื่นขอให้ผู้อ่านสร้างโปรเจ็กต์แบบ Windows Forms Application ว่างๆ ขึ้นมา 1 โปรเจ็กต์ ดังรูปที่ 

1-14

รูปที่ 1-14

แสดงแถบ Toolbox

จากรูปที่  1-14 

แถบคอนโทรล (Control) 

อยู่ด้านซ้ายมือ ท�าหน้าที่

ออกแบบส่วนแสดงผล 

(User Interface เรียก

ย่อๆ ว่า UI) ในขั้นต้นนี้ 

ผู ้อ ่ านสามารถใช ้งาน

คอนโทรลได้ 2 วิธี

1. ดับเบิลคลิกที่ตัวคอนโทรลเพื่อก�าหนดให้ Visual Studio ใช้งานคอนโทรลดังกล่าวในหน้าจอออกแบบ

โดยอัตโนมัติ เช่น ผู้เขียนต้องการใช้ปุมกด Button1 ดังรูปที่ 1-15

รูปที่ 1-15

แสดงการใช้ปุม
กดด้วยวิธีการ
ดับเบิลคลิกในแถบ 
Toolbox

คอนโทรล Button1.2ดับเบิลคลิก1.1
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กำรปรับแตงคอนโทรลขั้นต้นด้วยวิธีแก้ไขคุณสมบัติ ( Property)
คอนโทรลต่างๆ ที่น�ามาใช้งานสามารถปรับแต่งหรือแก้ไขได้ในหน้าต่างคุณสมบัติ (Properties) กล่าวคือ 

เมื่อโฟกัสที่คอนโทรลตัวใดก็ตามหน้าต่างคุณสมบัติจะเปลี่ยนไปโดยอัตโนมัติ

รูปที่ 1-17

แสดงรายการ
คุณสมบัติของปุม
กด Button

รูปที่ 1-16

แสดงการใช้ปุมกด 
ด้วยวิธีวาด

2. คลิกเลือกคอนโทรลที่ต้องการใช้งานแล้วน�าไปวาดในส่วนของฟอร์ม (Form) ดังรูปที่ 1-16

จากรูปที่ 1-16 เราได้ส่วนแสดงผลง่ายๆ มา

แล้ว 1 หน้าจอ มีปุมกด Button เพียง 1 ปุม

เลือก2.1

วาด2.2

เลือก1

แสดงผล 2

จากรูปที่ 1-17 ส่วนแสดงผลปัจจุบันของผู้เขียนมีเพียง 1 ปุม เมื่อถูกโฟกัสหน้าต่างคุณสมบัติก็จะแสดง

รายการคุณสมบัติต่างๆ ของคอนโทรล Button ให้เราโดยอัตโนมัติ
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มือใหมต้องทรำบกอนเขียนโปรแกรมในโลกของ .NET
ก่อนทีจ่ะเข้าสูร่ายละเอยีดของการเขยีนโปรแกรมในโลกของ .NET Frawework ผูเ้ขยีนจะขอน�าเสนอหลักการ

พื้นฐานในภาพกว้างที่มือใหม่ต้องทราบในขั้นต้นเสียก่อน เพื่อปูพื้นฐานก่อนท่ีจะเข้าสู่รายละเอียดเนื้อหาส่วน

ต่างๆ ในแต่ละบทต่อไป

กำรออกแบบสวนแสดงผลด้วยคอนโทรล ( User Interface)
ไม่ว่าผู้อ่านจะสร้างโปรเจ็กต์ประเภทใดก็ตามใน Visual Studio 2015 ไมโครซอฟท์ก�าหนดให้สภาพ

แวดล้อมของตัวโปรแกรม Visual Studio 2015 มีลักษณะคล้ายกัน ใกล้เคียงกันมากที่สุดเท่าที่จะเป็นไปได้ เพื่อ

ให้นักพัฒนาคุ้นเคยกับตัวโปรแกรมได้ไม่ยาก

แม้ว่าภาพประกอบผู้เขียนจะใช้โปรเจ็กต์ประเภท Windows Forms Application ก็จริงอยู่ แต่สามารถ

เทียบเคียงได้กับโปรเจ็กต์ประเภทอื่นๆ ได้อีกด้วย ซึ่งจะเป็นเนื้อหาในภาคต่างๆ ในล�าดับต่อไป 

ก่อนอื่นขอให้ผู้อ่านสร้างโปรเจ็กต์แบบ Windows Forms Application ว่างๆ ขึ้นมา 1 โปรเจ็กต์ ดังรูปที่ 

1-14

รูปที่ 1-14

แสดงแถบ Toolbox

จากรูปที่  1-14 

แถบคอนโทรล (Control) 

อยู่ด้านซ้ายมือ ท�าหน้าที่

ออกแบบส่วนแสดงผล 

(User Interface เรียก

ย่อๆ ว่า UI) ในขั้นต้นนี้ 

ผู ้อ ่ านสามารถใช ้งาน

คอนโทรลได้ 2 วิธี

1. ดับเบิลคลิกที่ตัวคอนโทรลเพื่อก�าหนดให้ Visual Studio ใช้งานคอนโทรลดังกล่าวในหน้าจอออกแบบ

โดยอัตโนมัติ เช่น ผู้เขียนต้องการใช้ปุมกด Button1 ดังรูปที่ 1-15

รูปที่ 1-15

แสดงการใช้ปุม
กดด้วยวิธีการ
ดับเบิลคลิกในแถบ 
Toolbox

คอนโทรล Button1.2ดับเบิลคลิก1.1
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รูปที่ 1-18

แสดงรายการ
คุณสมบัติของ
คอนโทรล Label

รายการคุณสมบัติของคอนโทรล  Button ที่น่าสนใจ แสดงดังตารางต่อไปนี้

คุณสมบัติ หนาที่

Name ทําหนาที่ตั้งชื่อใหกับตัวคอนโทรล ใชสําหรับอางอิงตอนเขียนโคด

Text กําหนดขอความที่จะแสดงในปุมกด

BackColor กําหนดสีพื้นหลังใหกับปุมกด

ForeColor กําหนดสีตัวอักษรที่อยูในปุมกด

คุณสมบัติใดก็ตามที่ถูกแก้ไขจะแสดงด้วยตัวอักษรตัวหนา ส่วนตัวอักษรปกติ หมายถึง เป็นค่าเริ่มต้นที่

โปรแกรม Visual Studio ตั้งไว้ โดยที่ไม่จ�าเป็นต้องไปแก้ไขให้ครบทุกคุณสมบัติ แก้ไขเฉพาะเท่าที่จ�าเป็น

ต่อมาผู้เขียนลองใช้คอนโทรล Label ซึ่งท�าหน้าที่แสดงข้อความ เมื่อคอนโทรล Label ได้รับโฟกัสพบว่า 

ที่หน้าต่างคุณสมบัติจะแสดงรายการคุณสมบัติของคอนโทรล Label ให้เราโดยอัตโนมัติ

รายการคุณสมบัติที่น่าสนใจแสดงดังตารางต่อไปนี้

คุณสมบัติ หนาที่

Name ทําหนาที่ตั้งชื่อใหกับตัวคอนโทรล ใชสําหรับอางอิงตอนเขียนโคด

Text กําหนดขอความที่จะแสดงใน  Label

BackColor กําหนดสีพื้นหลังใหกับคอนโทรล Label

ForeColor กําหนดสีตัวอักษรที่อยูในคอนโทรล Label

AutoSize กําหนดขนาดของคอนโทรล Label มี 2 แบบ คือ

z	 True หมายถึง กําหนดให Label มีขนาดเทาที่ขอความแสดงอยู

z	 False หมายถึง คุณสามารถกําหนดขนาดของ Label ไดอยางอิสระ

คอนโทรลแต่ละตัวก็จะมีรายการคุณสมบัติทั้งที่เหมือนกันและต่างกันไปตามหน้าที่ของตัวมันเอง

เลือก1

แสดงผล 2
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 ท�ำควำมรู้จักกับฟอร์ม ( Form)
ไม่ว่าจะสร้างโปรเจ็กต์ประเภทใดก็ตาม โดยส่วนใหญ่จะมีส่วนแสดงผลเริ่มต้นมาให้ผู้อ่านใช้ออกแบบ

หน้าจอแรก (โปรเจ็กต์บางประเภทไม่ต้องมีส่วนแสดงผลเริ่มต้น) เช่น ในกรณีนี้เราสร้างโปรเจ็กต์แบบ Windows 

Forms Application ก็จะได้ฟอร์ม (Form) ที่มีชื่อว่า Form1 เป็นหน้าจอเริ่มต้น ดังรูปที่ 1-19

จากรูปที่ 1-19 เมื่อโฟกัสที่ Form1 หน้าต่างคุณสมบัติจะแสดงรายการคุณสมบัติของ Form1 เช่นกัน ที่

น่าสนใจก็คือ

คุณสมบัติ หนาที่

Name ทําหนาที่ตั้งชื่อใหกับฟอรม ใชสําหรับอางอิงตอนเขียนโคด

Text กําหนดขอความที่จะแสดงในแถบ Title Bar

BackColor กําหนดสีพื้นหลังใหกับฟอรม

ForeColor กําหนดสีตัวอักษรที่อยูในฟอรม

ในที่นี้ทดลองแก้ไขข้อความที่แสดงในแถบ Title Bar สามารถท�าได้ดังนี้

รูปที่ 1-19

แสดงรายการ
คุณสมบัติของ
ฟอร์ม

รูปที่ 1-20

แสดงการแก้ไข
คุณสมบัติ Text 
ของ Form1

เลือก1

แสดงผล 2

แสดงผล3

แกไขขอความ2

เลือก 1
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รูปที่ 1-18

แสดงรายการ
คุณสมบัติของ
คอนโทรล Label

รายการคุณสมบัติของคอนโทรล  Button ที่น่าสนใจ แสดงดังตารางต่อไปนี้

คุณสมบัติ หนาที่

Name ทําหนาที่ตั้งชื่อใหกับตัวคอนโทรล ใชสําหรับอางอิงตอนเขียนโคด

Text กําหนดขอความที่จะแสดงในปุมกด

BackColor กําหนดสีพื้นหลังใหกับปุมกด

ForeColor กําหนดสีตัวอักษรที่อยูในปุมกด

คุณสมบัติใดก็ตามที่ถูกแก้ไขจะแสดงด้วยตัวอักษรตัวหนา ส่วนตัวอักษรปกติ หมายถึง เป็นค่าเริ่มต้นที่

โปรแกรม Visual Studio ตั้งไว้ โดยที่ไม่จ�าเป็นต้องไปแก้ไขให้ครบทุกคุณสมบัติ แก้ไขเฉพาะเท่าที่จ�าเป็น

ต่อมาผู้เขียนลองใช้คอนโทรล Label ซึ่งท�าหน้าที่แสดงข้อความ เมื่อคอนโทรล Label ได้รับโฟกัสพบว่า 

ที่หน้าต่างคุณสมบัติจะแสดงรายการคุณสมบัติของคอนโทรล Label ให้เราโดยอัตโนมัติ

รายการคุณสมบัติที่น่าสนใจแสดงดังตารางต่อไปนี้

คุณสมบัติ หนาที่

Name ทําหนาที่ตั้งชื่อใหกับตัวคอนโทรล ใชสําหรับอางอิงตอนเขียนโคด

Text กําหนดขอความที่จะแสดงใน  Label

BackColor กําหนดสีพื้นหลังใหกับคอนโทรล Label

ForeColor กําหนดสีตัวอักษรที่อยูในคอนโทรล Label

AutoSize กําหนดขนาดของคอนโทรล Label มี 2 แบบ คือ

z	 True หมายถึง กําหนดให Label มีขนาดเทาที่ขอความแสดงอยู

z	 False หมายถึง คุณสามารถกําหนดขนาดของ Label ไดอยางอิสระ

คอนโทรลแต่ละตัวก็จะมีรายการคุณสมบัติทั้งที่เหมือนกันและต่างกันไปตามหน้าที่ของตัวมันเอง

เลือก1

แสดงผล 2
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กำรเพิ่มฟอร์มใหมเข้ำมำในโปรเจ็กต์
ในการพัฒนาแอพฯ ขึ้นมาใช้งาน โดยส่วนใหญ่จะต้องประกอบไปด้วยส่วนแสดงผลตั้งแต่ 2 หน้าจอขึ้นไป 

วิธีการเพิ่มหน้าจอใหม่เข้ามา ให้คลิกเมนู Project > Add New Item… ในกรณีนี้เราต้องการเพิ่มหน้าจอใหม่

ประเภท Windows Forms Application โดยตั้งชื่อว่า Form2 ดังรูปที่ 1-21

รูปที่ 1-21

แสดงการเพิ่ม
ฟอร์มที่ชื่อว่า 
Form2 เข้ามา
ในโปรเจ็กต์

จากรูปที่ 1-21 ณ จุดนี้โปรเจ็กต์ของเรามี 2 

ฟอร์มแล้ว

เลือก 1

เลือก 2 เลือก3

ตั้งชื่อ4
คลิก5

ฟอรมใหม6
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เริ่มต้นสร้ำงแอพพลิเคชันแรก
ในหวัข้อนีผู้อ่้านจะได้ใช้งาน Visual Studio 2015 เขยีนโปรแกรมด้วยภาษา Visual C# 2015 เป็นครัง้แรก 

โดยเปาหมายของแอพพลิเคชันนี้ก็คือแสดงข้อความ “Hello C#” โดยมีขั้นตอนดังนี้

1. ให้ผู้อ่านเลือกใช้คอนโทรล Label เข้ามาท�าหน้าที่แสดงข้อความ “Hello C#” โดยการลาก & วางใน 

Form1 ซึ่งท�าหน้าที่เป็นส่วนแสดงผล ดังรูปที่ 1-22

2. การก�าหนดข้อความใน Label ตัวนี้ ให้ผู้อ่านแก้ไขคุณสมบัติ Text ได้ที่หน้าต่าง Properties ให้เป็น

ข้อความตามที่ต้องการ

รูปที่ 1-22

แสดงการใช้งาน
คอนโทรล Label 
ใน Form1

รูปที่ 1-23

แสดงการแก้ไข
คุณสมบัติ Text 
ของคอนโทรล 
Label ตัวนี้

ลากวาง1

กาํหนดขอความ2
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3. การก�าหนดให้ Form1 ปรากฏอยู่กึ่งกลางหน้าจอที่คุณสมบัติ StartPosition เพราะเป็นคุณสมบัติที่

ท�าหน้าที่ก�าหนดต�าแหน่งของ Form1 โดยผู้เขียนเลือกแบบ CenterScreen หมายถึง ให้ปรากฏขึ้น

มากึ่งกลางหน้าจอ ดังรูปที่ 1-24

 
รูปที่ 1-24

แสดงการแก้ไข
ตําแหน่งของฟอร์ม 
ให้อยู่กึ่งกลาง
หน้าจอ

รูปที่ 1-25

แสดงการเริ่ม
ทดสอบโปรเจ็กต์

รูปที่ 1-26

ผลการทํางานของ
โปรเจ็กต์ปจจุบัน

จากรูปที่ 1-24 ณ จุดนี้ เราจะได้โปรเจ็กต์ตามที่ต้องการแล้ว

กำรทดสอบโปรเจ็กต์
หลังจากที่ผู้อ่านออกแบบและเขียนโค้ดแล้วก็จะเข้าสู่ขั้นตอนการทดสอบโปรเจ็กต์ เพื่อดูว่าแอพพลิเคชัน

ที่สร้างขึ้นท�างานตามที่ต้องการหรือไม่ โดยการคลิกปุม  เพื่อเริ่มต้นทดสอบรันโปรเจ็กต์

เลือก3.1

เลือก3.2

คลิก1

จากรปูที ่1-26 เหน็ได้ว่าเราได้ข้อความ “Hello C#” 

ปรากฏขึ้นมาใน Form1 ตามที่ต้องการแล้ว
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วิธีกำรสั่งให้เปดฟอร์มใหมโดยกำรเขียนโค้ด
ส�าหรับวิธีการสั่งให้เปดฟอร์มใหม่ที่เราเพิ่มเข้ามามีขั้นตอนดังนี้

1. ให้ดับเบิลคลิกปุม Button1 เพื่อสร้างเหตุการณ์ Click() 

2. เขียนโค้ดดังรูป

3. ให้ทดสอบรันโปรเจ็กต์ พบว่าเราสามารถเปด Form2 ได้แล้ว ดังรูปที่ 1-28

รูปที่ 1-27

แสดงโค้ดที่ใช้
สําหรับเปด 
Form2

รูปที่ 1-28

Form2 ที่ถูกเปด
จากปุมกด But-
ton1 ใน Form1

เขียนโคด2

คลิก3.1

แสดงผล3.2

ดับเบิลคลิก 1
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3. การก�าหนดให้ Form1 ปรากฏอยู่กึ่งกลางหน้าจอที่คุณสมบัติ StartPosition เพราะเป็นคุณสมบัติที่

ท�าหน้าที่ก�าหนดต�าแหน่งของ Form1 โดยผู้เขียนเลือกแบบ CenterScreen หมายถึง ให้ปรากฏขึ้น

มากึ่งกลางหน้าจอ ดังรูปที่ 1-24

 
รูปที่ 1-24

แสดงการแก้ไข
ตําแหน่งของฟอร์ม 
ให้อยู่กึ่งกลาง
หน้าจอ

รูปที่ 1-25

แสดงการเริ่ม
ทดสอบโปรเจ็กต์

รูปที่ 1-26

ผลการทํางานของ
โปรเจ็กต์ปจจุบัน

จากรูปที่ 1-24 ณ จุดนี้ เราจะได้โปรเจ็กต์ตามที่ต้องการแล้ว

กำรทดสอบโปรเจ็กต์
หลังจากที่ผู้อ่านออกแบบและเขียนโค้ดแล้วก็จะเข้าสู่ขั้นตอนการทดสอบโปรเจ็กต์ เพื่อดูว่าแอพพลิเคชัน

ที่สร้างขึ้นท�างานตามที่ต้องการหรือไม่ โดยการคลิกปุม  เพื่อเริ่มต้นทดสอบรันโปรเจ็กต์

เลือก3.1

เลือก3.2

คลิก1

จากรูปท่ี 1-26 เห็นได้ว่าเราได้ข้อความ “Hello C#” 

ปรากฏขึ้นมาใน Form1 ตามที่ต้องการแล้ว
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หลักกำรท�ำงำนของภำษำ C#
หลักการท�างานของภาษา C# เรียกว่า การเขียนโปรแกรมตอบสนองเหตุการณ์ที่เกิดขึ้น ( Event 

Driven Programming) กล่าวคือ ผู้อ่านเป็นผู้ก�าหนดเองว่าเมื่อเกิดเหตุการณ์ Click() ให้ท�าอะไร, เมื่อเกิด

เหตุการณ์ Load() ให้ท�าอะไร เป็นต้น

หมายความว่า แท้ที่จริงแล้วการกระท�าต่างๆ ท่ีผู้ใช้งานกระท�าต่อโปรแกรมของผู้อ่านเป็นผู้ก�าหนดขึ้น

มาเองทั้งสิ้นว่า “ให้ท�าอะไร” ประเด็นที่ตามมาก็คือ วิธีการสร้างเหตุการณ์ให้กับคอนโทรลแต่ละตัวท�าอย่างไร 

สมมติว่าผู้เขียนต้องการสร้างเหตุการณ์ Click() ให้กับปุมกด Button จะมีวิธีการดังนี้

1. ให้ลากปุมกด Button มาวางใน Form1 ดังรูปที่ 1-29

รูปที่ 1-29

แสดงการใช้งาน
คอนโทรล Button 
ใน Form1

รูปที่ 1-30

แสดงการสร้าง
เหตุการณ์ Click() 
ด้วยวิธีดับเบิลคลิก

โดยการสร้างเหตุการณ์ให้กับปุมกด Button1 นี้ มี 2 วิธี

1.1 ดบัเบลิคลกิคอนโทรล Button1 เพือ่สัง่ให้ VS สร้างเหตกุารณ์ประจ�าตวัของคอนโทรล Button ขึน้มา 

คอนโทรล Button ถูกสร้างขึ้นมาเพื่อท�าหน้าที่รองรับการคลิกจากผู้ใช้งาน ดังนั้น เหตุการณ์

ประจ�าตัวของคอนโทรล Button ก็คือ เหตุการณ์ Click()

อีเวนตที่ได1

แต่ละคอนโทรลมีเหตุการณ์ประจ�าตัวแตกต่างกัน ขึ้นอยู่กับว่าคอนโทรลตัวนั้นๆ ถูกสร้างข้ึนมาเพื่อ 

“ท�าหน้าที่อะไร”
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1.2 อีกวิธีหนึ่งก็คือ ให้โฟกัสที่คอนโทรล Button1 ก่อน จากนั้นคลิกปุมในหน้าต่าง Properties เพื่อ

เลอืกสร้างเหตกุารณ์ท่ีต้องการ จะเหน็ได้ว่าปุมกด Button รองรบัหลายเหตกุารณ์ ให้ดบัเบลิคลกิ

ที่ Click เพื่อสร้างเหตุการณ์ Click() ขึ้นมาส�าหรับปุมกด Button1 ปุมนี้

รูปที่ 1-31

แสดงเหตุการณ์ 
Click() ที่ได้จาก
วิธีเลือกสร้าง
เหตุการณ์

2. ผูเ้ขยีนลองตัง้โจทย์ง่ายๆ ว่า ต้องการแสดงข้อความ “Hello C#” เมือ่ผูใ้ช้งานคลิกปุม Button1 สามารถ

เขียนโค้ดก�าหนดการท�างานได้ดังนี้

Form1.cs
namespace HelloCS
{
    public partial class Form1 : Form
    {
        public Form1()
        {
            InitializeComponent();
        }

        private void button1_Click(object sender, EventArgs e)
        {
            MessageBox.Show(“Hello C#”, “คําทักทาย”);
        }
    }
}

จากโค้ดข้างต้นเป็นการสั่งให้แสดงข้อความ “Hello C#” โดยอาศัยคลาส MessageBox เข้ามาท�าหน้าที่

สร้างไดอะล็อกแสดงข้อความ ดังรูปที่ 1-32

เลือก2.2
เลือก2.1

ดับเบิลคลิก 3

บทที่ 1 เตรียมความพร้อมก่อนเริ่มต้นเขียนโปรแกรมด้วยภาษา Visual C# 2015 19

Professional Visual C# 2015

หลักกำรท�ำงำนของภำษำ C#
หลักการท�างานของภาษา C# เรียกว่า การเขียนโปรแกรมตอบสนองเหตุการณ์ที่เกิดขึ้น ( Event 

Driven Programming) กล่าวคือ ผู้อ่านเป็นผู้ก�าหนดเองว่าเมื่อเกิดเหตุการณ์ Click() ให้ท�าอะไร, เมื่อเกิด

เหตุการณ์ Load() ให้ท�าอะไร เป็นต้น

หมายความว่า แท้ที่จริงแล้วการกระท�าต่างๆ ท่ีผู้ใช้งานกระท�าต่อโปรแกรมของผู้อ่านเป็นผู้ก�าหนดขึ้น

มาเองทั้งสิ้นว่า “ให้ท�าอะไร” ประเด็นที่ตามมาก็คือ วิธีการสร้างเหตุการณ์ให้กับคอนโทรลแต่ละตัวท�าอย่างไร 

สมมติว่าผู้เขียนต้องการสร้างเหตุการณ์ Click() ให้กับปุมกด Button จะมีวิธีการดังนี้

1. ให้ลากปุมกด Button มาวางใน Form1 ดังรูปที่ 1-29

รูปที่ 1-29

แสดงการใช้งาน
คอนโทรล Button 
ใน Form1

รูปที่ 1-30

แสดงการสร้าง
เหตุการณ์ Click() 
ด้วยวิธีดับเบิลคลิก

โดยการสร้างเหตุการณ์ให้กับปุมกด Button1 นี้ มี 2 วิธี

1.1 ดบัเบลิคลกิคอนโทรล Button1 เพือ่สัง่ให้ VS สร้างเหตกุารณ์ประจ�าตวัของคอนโทรล Button ขึน้มา 

คอนโทรล Button ถูกสร้างขึ้นมาเพื่อท�าหน้าท่ีรองรับการคลิกจากผู้ใช้งาน ดังนั้น เหตุการณ์

ประจ�าตัวของคอนโทรล Button ก็คือ เหตุการณ์ Click()

อีเวนตที่ได1

แต่ละคอนโทรลมีเหตุการณ์ประจ�าตัวแตกต่างกัน ขึ้นอยู่กับว่าคอนโทรลตัวน้ันๆ ถูกสร้างข้ึนมาเพื่อ 

“ท�าหน้าที่อะไร”
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3. ในกรณีที่ดับเบิลคลิกบริเวณพื้นที่ว่างๆ ของ Form1 ส่งผลให้ C# จะสร้างเหตุการณ์ Load() ขึ้นมา 

เหตุการณ์ประจ�าตัวของ Form ก็คือเหตุการณ์ Load() เพื่อให้ผู้อ่านก�าหนดว่า เมื่อ Form1 ถูกโหลด

ขึ้นมาแล้วให้ท�าอะไร

รูปที่ 1-32

แสดงข้อความที่ได้

รูปที่ 1-33

แสดงที่จัดเก็บโค้ด
ภาษา C#

คลิก2.1

แสดงผล 2.2

จากรูปที่ 1-33 ที่หน้าต่าง Solution Explorer ท�าหน้าที่แสดงโครงสร้างของโปรเจ็กต์ปัจจุบัน ให้ผู้อ่าน

คลิกที่ Form1 (.cs) เพื่อแสดงโค้ดทั้งหมดที่อยู่ใน Form1

สรุปท้ำยบท
เน้ือหาในบทนี้เป็นเพียงข้ันตอนการเตรียมสภาพแวดล้อมให้เคร่ืองของผู้อ่านพร้อมใช้งานเท่านั้น เนื้อหา

ในบทต่อไปจะเข้าสู่โลกของการเขียนโปรแกรมอย่างแท้จริง

อีเวนตที่ได



Professional Visual C# 2015

บทที่ 1 เตรียมความพร้อมก่อนเริ่มต้นเขียนโปรแกรมด้วยภาษา Visual C# 2015 21

Professional Visual C# 2015

3. ในกรณีที่ดับเบิลคลิกบริเวณพื้นที่ว่างๆ ของ Form1 ส่งผลให้ C# จะสร้างเหตุการณ์ Load() ขึ้นมา 

เหตุการณ์ประจ�าตัวของ Form ก็คือเหตุการณ์ Load() เพื่อให้ผู้อ่านก�าหนดว่า เมื่อ Form1 ถูกโหลด

ขึ้นมาแล้วให้ท�าอะไร

รูปที่ 1-32

แสดงข้อความที่ได้

รูปที่ 1-33

แสดงที่จัดเก็บโค้ด
ภาษา C#

คลิก2.1

แสดงผล 2.2

จากรูปที่ 1-33 ที่หน้าต่าง Solution Explorer ท�าหน้าที่แสดงโครงสร้างของโปรเจ็กต์ปัจจุบัน ให้ผู้อ่าน

คลิกที่ Form1 (.cs) เพื่อแสดงโค้ดทั้งหมดที่อยู่ใน Form1

สรุปท้ำยบท
เนื้อหาในบทนี้เป็นเพียงข้ันตอนการเตรียมสภาพแวดล้อมให้เคร่ืองของผู้อ่านพร้อมใช้งานเท่านั้น เนื้อหา

ในบทต่อไปจะเข้าสู่โลกของการเขียนโปรแกรมอย่างแท้จริง

อีเวนตที่ได
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พื้นฐานการเขียนโปรแกรมด้วยภาษา 
Visual C#

CHAPTER

02

เนือ้หาในบทนีจ้ะเข้าสูโ่ลกของการเขยีนโปรแกรมด้วยภาษา VC# 2015 ด้วย Visual Studio 2015 ผูอ่้าน 

จะได้ศึกษาพื้นฐานและไวยากรณ์ทางภาษาที่ต้องทราบเป็นล�าดับแรกก่อนที่จะเข้าสู่หัวข้อต่อๆ  ไป

การประกาศตัวแปรขึ้นมาใช้เก็บข้อมูล
ไม่ว่าผู้อ่านจะเริ่มต้นศึกษาภาษาใดก็ตาม ไวยากรณ์ที่ต้องท�าความเข้าใจเป็นล�าดับแรก นั่นคือ การสร้าง

ตัวแปร (Variable) ขึ้นมา เพื่อท�าหน้าที่เก็บข้อมูลโดยการประกาศตัวแปรในภาษา VC# 2015 มีไวยากรณ์ดัง

ต่อไปนี้

VC# 2015

ชนิดข้อมูล ชื่อตัวแปร;

กฎการตั้งชื่อตัวแปรในภาษา C#
1. ตัวอักษรแรกของตัวแปรต้องขึ้นต้นด้วยตัวอักษรภาษาอังกฤษหรือเครื่องหมาย _ เท่านั้น ห้ามเป็น

ตัวเลขเด็ดขาด 

2. ตัวอักษรตั้งแต่ตัวที่ 2 เป็นต้นไปสามารถเป็นตัวเลขได้

3. ชื่อตัวแปรห้ามมีช่องว่าง นิยมใช้เครื่องหมาย _ แทนช่องว่าง 

4. ตัวอักษรภาษาอังกฤษพิมพ์ใหญ่และพิมพ์เล็กถือว่าเป็นคนละตัวกัน

5. ชื่อตัวแปรที่ตั้งขึ้นมาห้ามซ�้ากับค�าสงวนของภาษา C#
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ค�าสงวน (Reserved Words) ของภาษา C#
ค�าสงวน (Reserved Words) เป็นค�าที่ภาษา C# ก�าหนดไว้เพื่อเป็นค�าสั่งหรือไวยากรณ์ของภาษา C# 

ส�าหรับการเขียนโปรแกรม ส่งผลให้ไม่สามารถใช้ค�าเหล่านี้ตั้งชื่อตัวแปรได้ เพราะว่าจะซ�้ากับค�าสั่งของภาษา C# 

นั่นเอง ค�าสงวนที่น่าสนใจมีดังนี้

abstract

as

base

bool

break

byte

case

catch

char

checked

class

const

continue

decimal

default

delegate

do

double

else

enum

false

finally

float

for

foreach

goto

if

in

int

interface

internal

is 

long

namespace

new

null

object

operator

out

override

params

private

protected

public

readonly

ref

return

sbyte

sealed

short

sizeof

static

string

struct

switch

this

throw

true

try

typeof

uint

ulong

ushort

using

virtual

void

while

ตัวอย่างเช่น

 int intAge;

 float fGrade;

 int intMoney = 214;

ชนิดข้อมูล

ชื่อตัวแปร
ค่าข้อมูล

ในการเขียนโปรแกรมภาษา C# ค�าสั่งแต่ละค�าสั่งต้องปิดด้วยเครื่องหมาย ; เสมอ

ขอบเขตของตัวแปร (Variable Scope)
หลังจากทีผู้่อ่านประกาศตวัแปรทีต้่องการใช้งานแล้ว เนือ้หาล�าดบัถดัมาทีค่วรรบัทราบก็คอื ตวัแปรดังกล่าว 

มีขอบเขตที่สามารถเรียกใช้งานได้หรือไม่  ซึ่งมีขอบเขตอยู่ 3 ระดับคือ

1. ตัวแปรระดับฟอร์ม ถ้าผู้อ่านประกาศตัวแปรชนิดนี้ไว้ในฟอร์มจะมีขอบเขตกว้างมากที่สุด กล่าวคือ 

ทุกเหตุการณ์ที่อยู่ในฟอร์มนั้นๆ  สามารถเรียกใช้งานได้  
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Visual C#

CHAPTER

02

เนือ้หาในบทนีจ้ะเข้าสูโ่ลกของการเขยีนโปรแกรมด้วยภาษา VC# 2015 ด้วย Visual Studio 2015 ผูอ่้าน 

จะได้ศึกษาพื้นฐานและไวยากรณ์ทางภาษาที่ต้องทราบเป็นล�าดับแรกก่อนที่จะเข้าสู่หัวข้อต่อๆ  ไป

การประกาศตัวแปรขึ้นมาใช้เก็บข้อมูล
ไม่ว่าผู้อ่านจะเริ่มต้นศึกษาภาษาใดก็ตาม ไวยากรณ์ที่ต้องท�าความเข้าใจเป็นล�าดับแรก นั่นคือ การสร้าง

ตัวแปร (Variable) ขึ้นมา เพื่อท�าหน้าที่เก็บข้อมูลโดยการประกาศตัวแปรในภาษา VC# 2015 มีไวยากรณ์ดัง

ต่อไปนี้

VC# 2015

ชนิดข้อมูล ชื่อตัวแปร;

กฎการต้ังชื่อตัวแปรในภาษา C#
1. ตัวอักษรแรกของตัวแปรต้องขึ้นต้นด้วยตัวอักษรภาษาอังกฤษหรือเคร่ืองหมาย _ เท่าน้ัน ห้ามเป็น

ตัวเลขเด็ดขาด 

2. ตัวอักษรตั้งแต่ตัวที่ 2 เป็นต้นไปสามารถเป็นตัวเลขได้

3. ชื่อตัวแปรห้ามมีช่องว่าง นิยมใช้เครื่องหมาย _ แทนช่องว่าง 

4. ตัวอักษรภาษาอังกฤษพิมพ์ใหญ่และพิมพ์เล็กถือว่าเป็นคนละตัวกัน

5. ชื่อตัวแปรที่ตั้งขึ้นมาห้ามซ�้ากับค�าสงวนของภาษา C#
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2. ตัวแปรระดับ Local หรือเรียกอีกอย่างว่า ตัวแปรระดับ Procedure ก็ได้ มีขอบเขตขนาดกลาง เป็น

ระดับที่เหมาะสมกับการใช้งานมากที่สุด มีขอบเขตอยู่ในแต่ละเหตุการณ์

3. ตวัแปรระดบั Block มขีอบเขตขนาดเลก็สดุ มกัใช้เก็บค่าชัว่คราวหรอืตวัแปรใช้วนลปูเสยีเป็นส่วนใหญ่ 

เช่น ตัวแปรที่อยู่ในบล็อกของค�าสั่งต่างๆ  

ค�าว่า เหมาะสม หมายถึง ในการเรียกใช้งานตัวแปรทั้งหมดที่อยู่ในโปรเจ็กต์ของผู้อ่าน สิ่งหนึ่งที่ต้อง

ค�านึงถึงก็คือ หน่วยความจ�า (RAM) การเขียนโปรแกรมที่ดีจะต้องมีการใช้งานทรัพยากรระบบให้เหมาะสม

กับความสามารถของตัวมันเอง

ส�าหรบัการเลอืกใช้ตวัแปรระดบัใดกต็าม ไม่มข้ีอก�าหนดตายตวั หรอืข้อบงัคบัใดๆ ทัง้สิน้ ขึน้อยูก่บัลกัษณะ

ของโปรเจ็กต์ของผู้อ่านเสียมากกว่า ขอให้เลือกใช้ตามความเหมาะสม 

ขอบเขตของตัวแปรจะเป็นตัวบ่งบอกว่า ตัวแปรนั้นๆ  จะมีอายุในการท�างานนานเท่าไร เพราะเมื่อสิ้นสุด

การท�างานของตัวแปรนั้นๆ  แอพพลิเคชันจะคืนทรัพยากรที่จองมาใช้งานกลับสู่ระบบ ถ้าผู้อ่านเลือกใช้ขอบเขต

และประเภทของตัวแปรได้อย่างเหมาะสมแล้ว โปรเจ็กต์ที่ได้ก็จะมีทั้งประสิทธิภาพในด้านการท�างานและการใช้

ทรัพยากรระบบ ตัวอย่างเช่น

ผู้เขียนประกาศตัวแปรขึ้นมา 2 ตัว คือ ตัวแปร num ก�าหนดให้มีชนิดข้อมูลเป็นตัวเลขจ�านวนเต็ม int 

และก�าหนดค่าเริ่มต้นให้เก็บค่า 1000 ส่วนตัวแปร str ก�าหนดให้มีชนิดข้อมูลเป็นข้อความ string และก�าหนด

ค่าเริ่มต้นเป็นชื่อ-สกุลผู้เขียน

VC# 2015

        private void Form1_Load(object sender, EventArgs e)

        {

            int num = 1000;

            string str = “Suphachai Somphanit”;

        }

ตวัแปรทัง้ 2 ตวั ถกูประกาศให้อยูภ่ายในเหตกุารณ์ Form1_Load() เราเรยีกตวัแปรประเภทนีว่้า ตวัแปร
ที่มีขอบเขตแบบ Local หมายถึง สามารถใช้งานได้เฉพาะ “ภายในเหตุการณ์ Form1_Load()” เท่านั้น

ต่อมาผู้เขียนลองประกาศตัวแปรอีกลักษณะหนึ่ง ต�าแหน่งที่ประกาศตัวแปรอยู่ภายนอกเหตุการณ์ต่างๆ  

กล่าวคือ สร้างตัวแปรที่ชื่อว่า str ขึ้นมา ก�าหนดให้มีชนิดข้อมูลเป็นข้อความ string

VC# 2015
    public partial class Form1 : Form
    {
        public Form1()
        {
            InitializeComponent();
        }
        string str = "";
        private void Form1_Load(object sender, EventArgs e)
        {
            str = "Visual C#";

เหตุการณ์

ชื่อตัวแปร
ชนิดข้อมูล

ค่าข้อมูล
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        }

        private void button1_Click(object sender, EventArgs e)
        {
            str = "Visual C#"
        }
    }

ในกรณีนี้ตัวแปร str ถูกประกาศอยู่ภายนอกเหตุการณ์ต่างๆ  เรียกว่า ตัวแปรที่มีขอบเขตระดับฟอร์ม 

ผู้อ่านสามารถเรียกใช้ตัวแปร str นี้ในเหตุการณ์ต่างๆ  ได้ ในกรณีนี้คือเหตุการณ์ Form1_Load() กับเหตุการณ์ 

button1_Click() 

ตัวแปรระดับ Local และระดับฟอร์ม
เพื่อเพิ่มความเข้าใจในการใช้งานตัวแปรระดับ Local และระดับฟอร์ม ให้ผู้อ่านศึกษาการใช้งานตัวแปร

จากตัวอย่างต่อไปนี้

1. ออกแบบฟอร์มดังรูป 2-1

2. เขียนโค้ดในเหตุการณ์ Form1_Load() ดังนี้

ตัวอย่างที่ 2-1 ตัวแปรระดับ Local และระดับฟอร์ม (Form1.cs)
    public partial class Form1 : Form
    { 
        public Form1()
        {
            InitializeComponent();
        }
        string str = “ตัวแปรระดับฟอร์ม”;

        private void Form1_Load(object sender, EventArgs e)
        {
            //string str = "ตัวแปรระดับ Local";
            label1.Text = str;
        }
    }

3. เขียนโค้ดในเหตุการณ์ button1_Click() ดังนี้

ตัวอย่างที่ 2-1 ตัวแปรระดับ Local และระดับฟอร์ม (Form1.cs)

    public partial class Form1 : Form
    { 
        public Form1()
        {
            InitializeComponent();
        }
        string str = “ตัวแปรระดับฟอร์ม”;

        private void Form1_Load(object sender, EventArgs e)
        {
            //string str = "ตัวแปรระดับ Local";
            label1.Text = str;
        }

เหตุการณ์
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2. ตัวแปรระดับ Local หรือเรียกอีกอย่างว่า ตัวแปรระดับ Procedure ก็ได้ มีขอบเขตขนาดกลาง เป็น

ระดับที่เหมาะสมกับการใช้งานมากที่สุด มีขอบเขตอยู่ในแต่ละเหตุการณ์

3. ตัวแปรระดบั Block มขีอบเขตขนาดเลก็สดุ มกัใช้เก็บค่าชัว่คราวหรอืตวัแปรใช้วนลปูเสยีเป็นส่วนใหญ่ 

เช่น ตัวแปรที่อยู่ในบล็อกของค�าสั่งต่างๆ  

ค�าว่า เหมาะสม หมายถึง ในการเรียกใช้งานตัวแปรทั้งหมดที่อยู่ในโปรเจ็กต์ของผู้อ่าน สิ่งหน่ึงที่ต้อง

ค�านึงถึงก็คือ หน่วยความจ�า (RAM) การเขียนโปรแกรมที่ดีจะต้องมีการใช้งานทรัพยากรระบบให้เหมาะสม

กับความสามารถของตัวมันเอง

ส�าหรบัการเลอืกใช้ตวัแปรระดบัใดกต็าม ไม่มข้ีอก�าหนดตายตวั หรอืข้อบงัคบัใดๆ ทัง้สิน้ ขึน้อยูก่บัลกัษณะ

ของโปรเจ็กต์ของผู้อ่านเสียมากกว่า ขอให้เลือกใช้ตามความเหมาะสม 

ขอบเขตของตัวแปรจะเป็นตัวบ่งบอกว่า ตัวแปรนั้นๆ  จะมีอายุในการท�างานนานเท่าไร เพราะเมื่อสิ้นสุด

การท�างานของตัวแปรนั้นๆ  แอพพลิเคชันจะคืนทรัพยากรที่จองมาใช้งานกลับสู่ระบบ ถ้าผู้อ่านเลือกใช้ขอบเขต

และประเภทของตัวแปรได้อย่างเหมาะสมแล้ว โปรเจ็กต์ที่ได้ก็จะมีทั้งประสิทธิภาพในด้านการท�างานและการใช้

ทรัพยากรระบบ ตัวอย่างเช่น

ผู้เขียนประกาศตัวแปรขึ้นมา 2 ตัว คือ ตัวแปร num ก�าหนดให้มีชนิดข้อมูลเป็นตัวเลขจ�านวนเต็ม int 

และก�าหนดค่าเริ่มต้นให้เก็บค่า 1000 ส่วนตัวแปร str ก�าหนดให้มีชนิดข้อมูลเป็นข้อความ string และก�าหนด

ค่าเริ่มต้นเป็นชื่อ-สกุลผู้เขียน

VC# 2015

        private void Form1_Load(object sender, EventArgs e)

        {

            int num = 1000;

            string str = “Suphachai Somphanit”;

        }

ตวัแปรทัง้ 2 ตวั ถกูประกาศให้อยูภ่ายในเหตกุารณ์ Form1_Load() เราเรยีกตวัแปรประเภทนีว่้า ตวัแปร
ที่มีขอบเขตแบบ Local หมายถึง สามารถใช้งานได้เฉพาะ “ภายในเหตุการณ์ Form1_Load()” เท่านั้น

ต่อมาผู้เขียนลองประกาศตัวแปรอีกลักษณะหนึ่ง ต�าแหน่งที่ประกาศตัวแปรอยู่ภายนอกเหตุการณ์ต่างๆ  

กล่าวคือ สร้างตัวแปรที่ชื่อว่า str ขึ้นมา ก�าหนดให้มีชนิดข้อมูลเป็นข้อความ string

VC# 2015
    public partial class Form1 : Form
    {
        public Form1()
        {
            InitializeComponent();
        }
        string str = "";
        private void Form1_Load(object sender, EventArgs e)
        {
            str = "Visual C#";

เหตุการณ์

ชื่อตัวแปร
ชนิดข้อมูล

ค่าข้อมูล
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        private void button1_Click(object sender, EventArgs e)
        {
            label2.Text = str; 
        }
    }

4. เมื่อรันโปรแกรมจะได้ผลลัพธ์ดังนี้

รูปที่ 2-1

ผลการรันตัวอย่าง
ที่ 2-1

จากรูปที่ 2-1 ผู้เขียนประกาศตัวแปรในระดับฟอร์มที่ชื่อว่า str เห็นได้ว่าคอนโทรล label1 ถูกก�าหนดค่า

ในเหตุการณ์ Form1_Load() ส่วนคอนโทรล label2 ถูกก�าหนดค่าในเหตุการณ์ button1_Click() 

เห็นได้ว่าการประกาศตัวแปรในลักษณะนี้ ผู้อ่านสามารถใช้งานตัวแปร str นี้ได้หลายเหตุการณ์ คือ 

เหตุการณ์ Form1_Load() และเหตุการณ์ button1_Click()

5. ให้ผู้อ่านน�าหมายเหตุโค้ดบรรทัดต่อไปนี้ออก แล้วลองรันตัวอย่างอีกครั้ง ดังรูปที่ 2-2

VC# 2015
        private void Form1_Load(object sender, EventArgs e)
        {
            string str = "ตัวแปรระดับ Local";
            label1.Text = str;
        }

6. เมื่อรันโปรแกรมจะได้ผลลัพธ์ดังนี้

เหตุการณ์ (Click)

รูปที่ 2-2

หลังจากเอา
หมายเหตุออก

จากรูปที่ 2-2 ผู้เขียนสร้างตัวแปรอีก 1 ตัว มีขอบเขตระดับ Local ถูกประกาศภายในเหตุการณ์ Form1_

Load() มีขอบเขตเรียกใช้งานเฉพาะเหตุการณ์ Form1_Load() เท่านั้น ผู้เขียนจงใจให้มีชื่อเดียวกับตัวแปรระดับ

ฟอร์มข้างต้น พบว่าคอนโทรล label1 แสดงข้อความของตัวแปรในระดับ Local ก่อน

สรุปได้ว่าถ้ามีตัวแปรชื่อเดียวกันทั้งในระดับฟอร์มกับระดับ Local ตัวแปรท่ีอยู่ในระดับ Local มีความ

ส�าคัญมากกว่าตัวแปรที่อยู่ในระดับฟอร์ม
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4. ให้เอาหมายเหตุออก พบว่าไม่สามารถอ่านค่าของตัวแปร strVal ตัวนี้นอกลูป for ได้เลย ดังรูปที่ 2-4

ตัวแปรระดับ Block
เพ่ือเพ่ิมความเข้าใจในการใช้งานตวัแปรระดบั Block ซึง่เป็นตวัแปรทีม่ขีอบเขตแคบท่ีสุด ให้ผูอ่้านศกึษาการ 

ใช้งานตัวแปรจากตัวอย่างต่อไปนี้ 

1. ออกแบบฟอร์มดังรูป 2-3

2. เขียนโค้ดในเหตุการณ์ Form1_Load() ดังนี้

ตัวอย่างที่ 2-2 ตัวแปรระดับ Block (Form1.cs)
    public partial class Form1 : Form
    {
        public Form1()
        {
            InitializeComponent();
        }

        private void Form1_Load(object sender, EventArgs e)
        {
            int i = 0;
            for (i = 0; i <= 2; i++)
            {
                string strVal = "ตัวแปรระดับ Block";
                label1.Text = strVal;
            }
            //label1.Text = strVal;
        }
    }

3. เมื่อรันโปรแกรมจะได้ผลลัพธ์ดังนี้

รูปที่ 2-4

แสดงการใช้งาน
ตัวแปร strVal 
นอกบล็อกค�าสั่ง  
for

รูปที่ 2-3

ผลการรันตัวอย่าง
ที่ 2-2

แสดงข้อผิดพลาด

จากรูปที่ 2-3 ผู้เขียนประกาศตัวแปรที่

ชื่อว่า strVal ในบล็อกค�าสั่งของลูป for ส่งผล

ให้ตัวแปรตัวนี้ มีขอบเขตการใช้งานในบล็อก

ของลูป for นี้เท่านั้น 

จากรูปที่ 2-4 ข้อผิดพลาดที่ปรากฏขึ้นมา เกิดจากตัวแปร strVal ยังไม่มีการประกาศใช้งาน เพราะว่าเรา

เรียกใช้งานตัวแปรตัวนี้เกินขอบเขตของมันนั่นเอง
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        private void button1_Click(object sender, EventArgs e)
        {
            label2.Text = str; 
        }
    }

4. เมื่อรันโปรแกรมจะได้ผลลัพธ์ดังนี้

รูปที่ 2-1

ผลการรันตัวอย่าง
ที่ 2-1

จากรูปที่ 2-1 ผู้เขียนประกาศตัวแปรในระดับฟอร์มที่ชื่อว่า str เห็นได้ว่าคอนโทรล label1 ถูกก�าหนดค่า

ในเหตุการณ์ Form1_Load() ส่วนคอนโทรล label2 ถูกก�าหนดค่าในเหตุการณ์ button1_Click() 

เห็นได้ว่าการประกาศตัวแปรในลักษณะนี้ ผู้อ่านสามารถใช้งานตัวแปร str นี้ได้หลายเหตุการณ์ คือ 

เหตุการณ์ Form1_Load() และเหตุการณ์ button1_Click()

5. ให้ผู้อ่านน�าหมายเหตุโค้ดบรรทัดต่อไปนี้ออก แล้วลองรันตัวอย่างอีกครั้ง ดังรูปที่ 2-2

VC# 2015
        private void Form1_Load(object sender, EventArgs e)
        {
            string str = "ตัวแปรระดับ Local";
            label1.Text = str;
        }

6. เมื่อรันโปรแกรมจะได้ผลลัพธ์ดังนี้

เหตุการณ์ (Click)

รูปที่ 2-2

หลังจากเอา
หมายเหตุออก

จากรูปที่ 2-2 ผู้เขียนสร้างตัวแปรอีก 1 ตัว มีขอบเขตระดับ Local ถูกประกาศภายในเหตุการณ์ Form1_

Load() มีขอบเขตเรียกใช้งานเฉพาะเหตุการณ์ Form1_Load() เท่านั้น ผู้เขียนจงใจให้มีชื่อเดียวกับตัวแปรระดับ

ฟอร์มข้างต้น พบว่าคอนโทรล label1 แสดงข้อความของตัวแปรในระดับ Local ก่อน

สรุปได้ว่าถ้ามีตัวแปรชื่อเดียวกันทั้งในระดับฟอร์มกับระดับ Local ตัวแปรท่ีอยู่ในระดับ Local มีความ

ส�าคัญมากกว่าตัวแปรที่อยู่ในระดับฟอร์ม
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ชนิดข้อมูล (Type)
ในภาษา VC# 2015 มีการแบ่งข้อมูลออกเป็น 2 กลุ่มใหญ่ คือ

1. Value types ประกอบด้วยข้อมลูชนดิตวัเลขจ�านวนเตม็กบัตวัเลขทศนยิม (Numeric), ค่าทางตรรกะ 

(Boolean), ตัวเลขจ�านวนจรงิ หรอืตวัเลขทศนยิม (Real Number) และตวัอกัษร (Character) อาจจะ 

เรียกข้อมูลกลุ่มนี้ว่า ข้อมูลพื้นฐาน (Primitive Data Types) ก็ได้

2. Reference types ประกอบด้วยข้อมูล 2 ประเภท คือ ข้อความ (String) และออบเจ็กต์ (Object)

เนื้อหาของหัวข้อนี้จะกล่าวถึงเฉพาะชนิดข้อมูลในกลุ่ม Value types เท่านั้น ซึ่งถือเป็นชนิดข้อมูล 

พื้นฐานที่ต้องท�าความเข้าใจเป็นล�าดับแรก

ขอบเขตการจัดเก็บข้อมูลแต่ละชนิดข้อมูล และขนาดหน่วยความจ�า
ที่ใช้

ชนิดข้อมูล (Type) แต่ละประเภทที่ผู้อ่านก�าหนดให้ตัวแปรแต่ละตัว มีความสามารถในการจัดเก็บตัวเลข

ไม่เท่ากัน มากน้อยไปตามแต่ละชนิด เกิดมาจากการใช้พื้นที่ในหน่วยความจ�า (RAM) ไม่เท่ากัน 

ในหวัข้อนีผู้เ้ขยีนต้องการตรวจสอบว่า ชนดิข้อมลูแต่ละประเภทมขีอบเขตและใช้ขนาดหน่วยความจ�าเท่าใด 

โดยตรวจสอบด้วยโค้ดโปรแกรมในตัวอย่างที่ 2-3 

ตัวอย่างที่ 2-3  ขอบเขตการจัดเก็บข้อมูลแต่ละชนิดข้อมูลและขนาดหน่วยความจ�าที่ใช้ มีดังโค้ดต่อไปนี้

ตัวอย่างที่ 2-3 ขอบเขตการจัดเก็บข้อมูลแต่ละชนิดข้อมูล และขนาดหน่วยความจ�าที่ใช้ (Form.cs)
    public partial class Form1 : Form
    {
        public Form1()
        {
            InitializeComponent();
        }

        private void Form1_Load(object sender, EventArgs e)
        {
            string result = "";

            sbyte sb = 0;
            result = "ค่า Min : " + sbyte.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + sbyte.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(sbyte.MaxValue.GetType()) + Environment.
NewLine;
            result += "Type : " + sb.GetType().ToString();
            MessageBox.Show(result.ToString(), "SByte");

            short sh = 0;
            result = "ค่า Min : " + short.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + short.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(short.MaxValue.GetType()) + Environment.
NewLine;
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            result += "Type : " + sh.GetType().ToString();
            MessageBox.Show(result.ToString(), "Short");

            int i = 0;
            result = "ค่า Min : " + int.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + int.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(int.MaxValue.GetType()) + Environment.
NewLine;
            result += "Type : " + i.GetType().ToString();
            MessageBox.Show(result.ToString(), "Integer");

            long l = 0;
            result = "ค่า Min : " + long.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + long.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(long.MaxValue.GetType()) + Environment.
NewLine;
            result += "Type : " + l.GetType().ToString();
            MessageBox.Show(result.ToString(), "Long");

            byte b = 0;
            result = "ค่า Min : " + byte.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + byte.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(byte.MaxValue.GetType()) + Environment.
NewLine;
            result += "Type : " + b.GetType().ToString();
            MessageBox.Show(result.ToString(), "Byte");
            ushort us = 0;
            result = "ค่า Min : " + ushort.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + ushort.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(ushort.MaxValue.GetType()) + Environment.
NewLine;            result += "Type : " + us.GetType().ToString();
            MessageBox.Show(result.ToString(), "UShort");

            uint ui = 0;
            result = "ค่า Min : " + uint.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + uint.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(uint.MaxValue.GetType()) + Environment.
NewLine;
            result += "Type : " + ui.GetType().ToString();
            MessageBox.Show(result.ToString(), "UInteger");

            ulong ul = 0;
            result = "ค่า Min : " + ulong.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + ulong.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(ulong.MaxValue.GetType()) + Environment.
NewLine;
            result += "Type : " + ul.GetType().ToString();
            MessageBox.Show(result.ToString(), "ULong");

            float sng = 0;
            result = "ค่า Min : " + float.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + float.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(float.MaxValue.GetType()) + Environment.
NewLine;
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ชนิดข้อมูล (Type)
ในภาษา VC# 2015 มีการแบ่งข้อมูลออกเป็น 2 กลุ่มใหญ่ คือ

1. Value types ประกอบด้วยข้อมลูชนดิตวัเลขจ�านวนเตม็กบัตวัเลขทศนยิม (Numeric), ค่าทางตรรกะ 

(Boolean), ตัวเลขจ�านวนจรงิ หรอืตวัเลขทศนยิม (Real Number) และตวัอกัษร (Character) อาจจะ 

เรียกข้อมูลกลุ่มนี้ว่า ข้อมูลพื้นฐาน (Primitive Data Types) ก็ได้

2. Reference types ประกอบด้วยข้อมูล 2 ประเภท คือ ข้อความ (String) และออบเจ็กต์ (Object)

เนื้อหาของหัวข้อนี้จะกล่าวถึงเฉพาะชนิดข้อมูลในกลุ่ม Value types เท่าน้ัน ซึ่งถือเป็นชนิดข้อมูล 

พื้นฐานที่ต้องท�าความเข้าใจเป็นล�าดับแรก

ขอบเขตการจัดเก็บข้อมูลแต่ละชนิดข้อมูล และขนาดหน่วยความจ�า
ที่ใช้

ชนิดข้อมูล (Type) แต่ละประเภทที่ผู้อ่านก�าหนดให้ตัวแปรแต่ละตัว มีความสามารถในการจัดเก็บตัวเลข

ไม่เท่ากัน มากน้อยไปตามแต่ละชนิด เกิดมาจากการใช้พื้นที่ในหน่วยความจ�า (RAM) ไม่เท่ากัน 

ในหวัข้อนีผู้เ้ขยีนต้องการตรวจสอบว่า ชนดิข้อมลูแต่ละประเภทมขีอบเขตและใช้ขนาดหน่วยความจ�าเท่าใด 

โดยตรวจสอบด้วยโค้ดโปรแกรมในตัวอย่างที่ 2-3 

ตัวอย่างที่ 2-3  ขอบเขตการจัดเก็บข้อมูลแต่ละชนิดข้อมูลและขนาดหน่วยความจ�าที่ใช้ มีดังโค้ดต่อไปนี้

ตัวอย่างที่ 2-3 ขอบเขตการจัดเก็บข้อมูลแต่ละชนิดข้อมูล และขนาดหน่วยความจ�าที่ใช้ (Form.cs)
    public partial class Form1 : Form
    {
        public Form1()
        {
            InitializeComponent();
        }

        private void Form1_Load(object sender, EventArgs e)
        {
            string result = "";

            sbyte sb = 0;
            result = "ค่า Min : " + sbyte.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + sbyte.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(sbyte.MaxValue.GetType()) + Environment.
NewLine;
            result += "Type : " + sb.GetType().ToString();
            MessageBox.Show(result.ToString(), "SByte");

            short sh = 0;
            result = "ค่า Min : " + short.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + short.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(short.MaxValue.GetType()) + Environment.
NewLine;
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            result += "Type : " + sng.GetType().ToString();
            MessageBox.Show(result.ToString(), "Single");

            double dbl = 0;
            result = "ค่า Min : " + double.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + double.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(double.MaxValue.GetType()) + Environment.
NewLine;
            result += "Type : " + dbl.GetType().ToString();
            MessageBox.Show(result.ToString(), "Double");

            decimal dc = default(decimal);
            result = "ค่า Min : " + decimal.MinValue.ToString() + Environment.NewLine;
            result += "ค่า Max : " + decimal.MaxValue.ToString() + Environment.NewLine;
            result += "ขนาด (ไบต์) : " + Marshal.SizeOf(decimal.MaxValue.GetType()) + Environment.
NewLine;
            result += "Type : " + dc.GetType().ToString();
            MessageBox.Show(result.ToString(), "Decimal");

            char ch = ‘\0’;
            result = "Type : " + ch.GetType().ToString();
            MessageBox.Show(result.ToString(), "Char");

            bool bl = false;
            result = "Type : " + bl.GetType().ToString();
            MessageBox.Show(result.ToString(), "Boolean");
        }
    }

เมื่อรันโปรแกรมจะได้ผลลัพธ์ดังนี้

        
รูปที่ 2-5

ผลการรันตัวอย่าง
ที่ 2-3

จากรูปที่ 2-5 เป็นผลการตรวจสอบชนิดข้อมูลบางส่วน ได้แก่ sbyte, short และ int ผู้เขียนสรุปขอบเขต

และขนาดหน่วยความจ�าที่ใช้ ดังตารางต่อไปนี้

ชนิดข้อมูล C# Type .NET Framework Type 
(CLR Type)

ขนาดไบต์ ขอบเขตของข้อมูล

จ�ำนวนเต็ม sbyte System.Sbyte 1 -128 ถึง 127

short System.Int16 2 -32768 ถึง 32767

int System.Int32 4 -2147483648 ถึง 

2147483647


